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Access 2010 Database Concepts 

What is a database? 

A database is defined as an organized collection of data (information) on people or 
things.  In raw form, a sheet of paper divided into columns and rows or a table in 

Microsoft Word or Excel is considered a simple database.  Single table databases 
are very limited in their uses and would not be considered as a business solution. 

In Access this information is stored in tables.  The information can be seen in tables 
or through forms and reports. A database will be able to store data in a structured 
manner across multiple tables, use queries to locate specific information according 

to given criteria, produce detailed (on-screen or printed) reports, perform 
calculations and much more.   

An example of a multi-table database is a database of classes, which might consist 
of tables showing information on several of these:  classes, instructors, students, 

and rooms. 

NOTE:  Access 2010 saves database files with an .accdb file name extension.  The 
data in the database is saved automatically when you enter it.  However, changes 

to an object such as a table, form or report need to be saved.  When necessary, 
Access will prompt for objects to be saved when switching views. 

What is a table? 

Tables are used to store the data in a structured and organized format.  As 
previously mentioned, tables are similar to those of Word and Excel, in that they 

contain rows (records) and columns (fields). 

 

What is a record (row)? 

A record applies to data entered into a single row of a table.  All data in that row 

would belong to an individual or item.  A record would normally include a unique ID 
number, name, description, plus other relevant information.  With each new record, 
a new row is created.  For example, the figure above has all the information on 

Peter in the row beginning with “1”. 

What is a field (column)? 

Each column (or field) is used to define what specific information is to be entered 
into that particular column or “field”.  A column titled „Class‟ for example would 

signify this to be the place in a record to enter the Class name when creating each 
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new record.  For example, the figure above has an email address for each row  
in the column headed “Email”. 

What is data? 

 Data is the information entered into tables within the database.  Databases are 

used in businesses and in education, often without people realizing they are 
using a database.  Something as simple as entering contact details into the 

„Contact‟ or „Address Book‟ section of an email client, involves entering data into 
a database. 

 Data entered will generally be alphabetical (names, addresses) or numerical 

(dates, currency), however Access is also able to store other forms of data, such 
as links to websites, documents created in other programs such as files & 

images. 

 Data can be entered into the database manually, via the keyboard, imported 
from or linked to external sources or even collected through email or an internet 

form. 

Data types 

Data types define what type of data will be entered into each „field‟ (column) in a 
table.  If you create a table by typing in the data in new fields, Access will 

determine the data type for you based on what you type.  If you type a name, it 
sets the type for that field to „Text‟.  If you type a date either as “12/09/2010” or 
“December 9, 2010” it will set the type to „Date/Time‟.  If you type a digit or digits 

it will set the type to „Number‟.  If you also type $ as in $49.95 or a specific number 
of decimal places “5.00” that will be included as the format for a numeric field.  

Although you can enter data without setting up the fields first, you should create 
the table and specify the data types for each field before entering data.  You should 
also set defaults, limits, and use Input Masks as needed. 

 
Text – holds up to 255 characters; can be numbers, letters, or symbols 

Memo – holds over 255 characters; can be numbers, letters, or symbols 

Number – numbers only 

Date/Time – valid dates or times 

Currency – numbers displayed as currency 

AutoNumber – a number is automatically input; you cannot type in this field 

Yes/No – only two answers:  yes or no   [true or false] [on or off]  

OLE Object – you can attach one document to the record 

Hyperlink – you can put in a hyperlink 

Attachment – attach multiple files to one record including digital photos 

Look Up Wizard – allows you to input a list of choices for a text field 

Calculated – displays a value calculated from other data in the table 
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Field Properties 

Field Properties should be set in order to: format numbers and dates; to limit 
data entry to specific characters; to validate entries; to provide a mask for input; to 
require data in a specific field; and/or to set default data.  You can see the Field 

Properties that have been set by viewing the table in Design View.  Some of the 
Field Properties are only available for 

specific Data Types.  Below is a brief 
description of some of the more popular 
Field Properties. 

Field Size allows the setting of the 
maximum number of characters that 

can be entered. 

Format allows you to specify a 
“format” or appearance of a date, time, 

or number.  It has choices such as:  
short date, medium time, long date, 

currency, etc. 

Input Mask uses a particular format of 
the data entered.  Such as a phone 

number (xxx) xxx-xxxx  or social security number xxx-xx-xxxx.  The Input Mask 
puts in the parenthesis, dashes, slashes while the user just types the data. 

Caption displays at the top of a column in a table. [It does not replace the field 
name.] 

Default Value is a value that is common, for example for a database with names 

and addresses, the State field could have a Default Value of:    TX 

Validation Rule & Validation Text allow you to set limits, for example on a 

Number or a Date field you could specify the number be less than or greater than a 
specific number or that a Date be between specific dates. 

Required can either be Yes or No.  Required Yes means that it will not allow the 

field to be empty. 

Indexed has three choices:  No, Yes (Duplicates OK), and Yes (No Duplicates).  

Indexed Yes means that searches and sorts work faster.  

Text Format ( Memo fields)has two choices:  Plain Text 

and Rich Text.  (Rich Text allows the person entering data 
to use bold, italic, underline and a few other features.) 

Text Align is used to set the alignment of text in the field. 

Show Date Picker is available for 
Date fields.  The Date Picker looks 

like a tiny calendar (small figure right).  
When you click the Date Picker, the 
current month calendar pops up (larger 

figure right). 
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A First Look at Access 2010 

Opening Access 2010 

 Click the Start button (bottom left of screen), then select All Programs.   Scroll 
up to locate the Microsoft Office folder button, click it.  Click Microsoft Office 

Access 2010.  Open the Sample2011 database. 

 

Exploring the Access 2010 window 

 Similar to other Microsoft Office 2010 applications, Access 2010 uses tabs which 
display a ribbon. The Ribbon is designed to display the most appropriate tools / 

functions according to the task at hand.  Each ribbon is divided into Groups.   

 The “biggest” change is the new (1) File tab in place of the Office Button. 

 The Quick Access Toolbar in the top left corner of the screen has not changed 
from Access 2010. 

 (2) Recent Documents are listed on the File tab. 

 (3) New Blank database is easy to access. 

 (4) Type the New database name and select the folder it will be stored in. 
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 Under the File tab in the top left corner is the Views group.  There are also two 
tiny View buttons in the bottom right corner of the screen. 

 At the bottom, near the center are the Record Navigation buttons.  Use the 
navigation buttons to display the records in a table.  In the “1 of 1” box the first 

number represents the current record and the second number is the total 
number of records. 

 

 All commands are organized into groups on 
the various Ribbons.  Groups were designed 

to help identify tools quickly. 

 A Dialog Box Launcher button, bottom 

right for the group (see figure on right) is 
available only on the Clipboard and Text 
Formatting groups on the Home tab 

ribbon.  When clicked, the Dialog Box 
Launcher displays a dialog box for selecting 

additional features. 

 

Minimizing the Ribbon 

 To minimize the Ribbon, click the small arrow on 

the left side of the Help ? button (see figure on 
right). 

 To make selections from a minimized ribbon, click 
on a ribbon tab.  The ribbon expands for you to 

make your selection. 

 When you click on a command button, the Ribbon 
minimizes again.  

 To restore the Ribbon to a fixed state, click the 
small arrow again. 
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Tabs and Ribbons 

Home – font formatting, record commands, sorting, filtering, & find 

Create – create tables, queries, forms, & reports 

External Data – import & export records from/to Excel and various other file types  

Database Tools – relationships and compact & repair database 

Table Tools Fields – views, insert, delete, or rename fields; set properties & data 

formatting 

Table Tools Table – (not shown) is for working with macros and programming 
steps to run 
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Customizing Access 2010 

Quick Access Toolbar 

 The Quick Access Toolbar offers an easy way to 
access frequently used command buttons, such as 

Save, Undo and Redo that are already on the 
Quick Access Toolbar.  Other functions may be 

added to the toolbar by selecting them from the 
Customize Quick Access Toolbar drop down 
list. 

 To customize the Quick Access Toolbar, click 
the drop-down arrow to the right of the Toolbar.  

The list has commands that you may easily turn 
on or off.  (A checkmark means they are on.) 

 You may also click More Commands and add 
additional commands to your Quick Access 
Toolbar.  Any command may be added to the 

Quick Access Toolbar. 

 

The File Tab & Access Options 

 The File tab provides many of the options previously found under the File drop 
down menu in earlier versions of Microsoft Access:  New, Open, Save, Save 

As, Print, and Close Database.  

 

 Also, on the File tab is 
Recent documents, 

Password protection, 
Compact & Repair 
Database and Access 

Options. 

 Click Recent.  It lists the 

documents that have 
been opened recently.  
You can specify how 

many documents to 
display in the Recent list 

(by changing the number 
at the bottom of the 
Recent screen).   

 You can also “pin” 
documents to the 

Recent list.  Click on the 
“pushpin” to the right of the Filename.  The document is now “pinned” to the 
Recent list.  Click the “pin” again to “unpin” the file. 
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 Click the File tab, 

then Options. 

 

 On the General 
screen, you may 
want to change 

the Default file 
format (see the 

figure).  If that is 
the only change 
click OK at the 

bottom of the 
Options window. 

 

 Still on the 
Options screen, click 

Current Database on the 
left.   Locate Document 

Window Options (across 
from Quick Access 

Toolbar).  

 Click Tabbed Documents 
to select it.  This will 

enable having tabs across 
the top of open files within 

Access, as shown in the figure on the right.   

 Click Object Designers, the fourth item in the Options menu.  If you would 
like to change the Default text field size, select 255 and type the number you 

want.  50 is 
suggested 

unless you 
think that is too 
low.  Click OK 

if finished with 
Options. 

 You can also make changes to the Quick Access Toolbar, select the Quick 
Access Toolbar in the menu on the left.  To add buttons to your toolbar, select 
a command in the list on the left, click the Add button and the command is 

added to the Toolbar on the right side of the screen.  Add as many commands 
as desired. 

 Click OK to keep the changes. 

An example of tabbed document windows 
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Opening a Database & Security Issues 

Opening a database 

 The Access 2010 program and the Sample2011 database should already be 
open, if they are not please open them. From the menu displayed on the left, 

click the Open command.  This will display the Open dialog box.  

 By default the contents of the My Documents folder will be displayed.  You 

should see a folder containing the Access data files.  Double click on this folder 
to display the contents. 

 Select a database file called Sample2011 and double click it.  The database 

may have a Security Warning like the one shown below. 

 

Security warnings 

 Similar to other Microsoft Office applications, Access 2010 warns users of 
potential security threats when they arise and relate to macros within the 

application. 

 Macros contain 
code written to 

perform a task 
within the 

application and 
are used widely 
in Excel, Word as 

well as Access.  
Because macros 

use code designed to allow advanced users the opportunity to create their own 
functions to enhance the functionality of a database, others can also write 

malicious code intended to have the opposite effect. For this reason, Microsoft 
Office applications prevent macros from running and displays a warning instead, 
which is outlined in 

the figure above. 
 

 Click the link “Click 
for more details” for 
additional 

information. 

 Click “Enable 

Content” to 
temporarily enable 
the file (this time 

only). 

 “Click for more 

details”, brings up 
the screen shown on the right. 
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 You can also click Enable Content (as a temporary fix). 

 Click Trust Center Settings to enable the contents of the file permanently. 

 If you trust the source of this database file and the content, you can select 
Enable content, to allow the macro to run, then click OK. 

NOTE:  Selecting Enable content is a temporary enabling of macros and warnings 
will be displayed again the next time this database is opened. 

 

Add a Trusted Location 

 You can add a trusted location so you do not 

get the security warning each time you open a 
database. 

 

 Click Trust Center Settings. 

 

 

 

 

 

 Click the Enable Trust 
Center logging checkbox (to 

turn it on).  

 

 

 

 

 

 

 Click Trusted 
Locations. 

 Click Add New 

Location. 
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 Click the Browse button, locate and 

click on the folder that you wish to 
add to the Trusted Locations. 

 Click Subfolders of this location 
are also trusted. 

 Click OK 

 The “new” location should be in the 
list of Trusted Locations. 

 

 Next time you open the database, you should not receive the security warning. 

Navigating an existing database 

 Still using the Sample2011 database (it should be open). 

 Open the Students table in the Sample2011 database file.  Scroll through the 

records using the record navigation buttons at the bottom of the table window.  
You can also scroll through fields with the Tab or arrow keys. 

 

Navigating through records within a table 

 The record navigation bar is located at the bottom 

of the object window. When a table is open, you 
will see these buttons.  (see figure on right) 

 To use the specific record option, click within the 

box and enter a record number, then press the 
Enter key. 

 Click below the last record. 

 

Add a New Record 

 Click under Kayla at the bottom of the list.  Type Krista in the First name field 

(once you type the name, 31 (or the next number) will show in the first 
(Student ID) column) press Tab.  [Press Ctrl and Quote to copy from the record 

above.]               

 For the Last name press Ctrl “”  press Tab;  
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 For the Address press Ctrl “”    press Tab;  

 For City press Ctrl “” press Tab twice to accept the State and in the Zip Code 

field press Ctrl “”  then press Tab;  

 Type the Phone Number shown – just type the digits 214 1234567 and the 

Input Mask (already set up) will put in the parenthesis, space, and dash in the 
correct places. 

Closing a database 

 Click the File tab to display the menu. 

 Select the Close Database command.  (This will close Sample2011 the open 

database.) 

 The database closes and returns to the Access 2010 “Available Templates” 

screen. The database name is listed on the left of the screen with the Recent 
Databases. 

Refer to this figure for creating a new database. 
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Creating a new blank database 

 Start the Access 2010 program if it is not already open.  (Refer to figure at 
bottom of previous page.) 

 Select the Blank Database icon, or if you are in Access, click the File tab and 

select New then click the Blank Database button.   

 Type Faculty in the File Name box (lower right).  Set the folder location for 

storing it in My Documents\Training (or wherever your instructor tells you to 
store it). 

 Click the Create button at the bottom of the screen. 

 A screen similar (and much larger)  to the one below is displayed:  

 

 

 

 

 

 

 

 

 

Saving a table 

 Before adding information to an Access database, the fields should be added to 

a table. The fields should be named, given the correct Data Type and formatted 
appropriately.  Field Properties should be selected as needed.  If necessary 

you can put validations in the fields as well as defaults. 

 Fields are used to organize data into specific fields or columns, for example a 
FirstName field would store the first name for every individual record entered, as 

would the LastName, BirthDate, and other 
fields, etc. 

 Click the Save button in the Quick Access 
Toolbar.  The Save As dialog box is 

displayed. Type the name Faculty.  Click 
the OK button.  [Each object:  Form, 
Query, Report, and Table has its own 

name] 
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Creating a Table & Setting Field Properties 

There are three main steps to creating the fields in a table. 

(1)  Type the Field Name (has to be unique in the table). 

(2)  Select the Field Type from the drop-down menu or by typing the first letter.   

Text is the default Field Type.  (see page 6 for Field Type descriptions) 

(3)  Set any Field Properties necessary.   (see page 7 for Field Property info) 

 

 Click the Design 
View button- top left 

to add to our table.  
See figure below to 

locate the Design 
View button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The first field is automatically created and is called ID and it is an AutoNumber 
Data Type.  It is the Primary Key.  Setting the field as the Primary Key causes 
entries in the field to be unique.  Change the Field Name to:  Faculty ID 

 Type the Field Name (1): LastName press the down-arrow key to go to the 
next field.  The third field should be FirstName, press the down arrow. (It will 

automatically make the Data Type Text.) 

 Text is the default Data Type.  [If you want a different Data Type, click the 

drop down arrow (2) in the figure above.]  Leave the Data Type as Text for both 
name fields. 

 The area at the bottom of the screen is titled Field Properties (3).  Set the 

Field Size to 30 for both name fields (FirstName & LastName); these fields will 
allow a maximum of 30 characters. 
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 Create the following fields, give Field Properties where specified in []. You 
have completed the first three. 

 Faculty ID AutoNumber 

 LastName Text   

[Field Size, 30] 

 FirstName Text   

[Field Size, 30] 

NOTE: Reducing the character length of a text 
field after data has been entered can result in 

loss of data in a field that had more text than 
the new limit. 

 Birthdate Date/Time     

[Format, Short Date] 

[Required, Yes] (Required will not allow 

blank fields) 

 Graduate Hrs Number  
[Validation Rule, >=18]     

[Validation Text, Must be equal to or 
greater than 18]  (this Validation Rule 

says it must be 18 or more)  

 PhD Yes/No 

 Campus        Text 

 Comments Memo  

[Text Format, Rich Text]  (Turning on Rich Text means you can use bold, italic 

& underline among other features) 

 Phone Text   

 Insert two new rows below 
FirstName.   

 Put the mouse on the left edge of 

Birthdate, click once and drag down 
to select both (1) Birthdate and 

Graduate Hrs  (see figure right). 

 Click (2) Insert Rows in the Tools 
group.  
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 Add the following two fields (on the new blank rows) below FirstName:  
County Text   

[Default value, Dallas] 

 State Text 

[Default  Value, TX] 

 Save the Faculty table again. 

 Move the Comments field to the bottom, below Phone: click the selection box 

on the far left to select it, then drag it to the bottom of the fields and let go] 

 Click the Datasheet View button in the Views group on the left edge of the 

Table Tools Design tab to view the new (empty) table. 

 Input one record in the table (make up information; try leaving the Birthdate 

field blank.  Also try entering a number less than 18 in the Graduate Hrs field), 
use the Tab key to move across from one field to another.   

 Instead of having to enter the name of the Campus, change the Data Type for 

Campus to Lookup Wizard.  The Lookup Wizard will begin. 

 On the first screen of the Lookup Wizard, select “I will type in the values that I 

want.” Click Next. 

 On the second screen (shown 
right) type the names of the 

seven campuses, one per 
line:  Brookhaven, Cedar 

Valley, Eastfield, El 
Centro, Mountain View, 

Northlake, Richland.  
(Press the down arrow to go 
down one line for each 

campus.)  

 Click Next. 
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 The third and final screen has 
two options.  See the figure 

(right). 

 Type Campus for the label. 

 Select either “Limit To List” 
OR “Allow Multiple Values”. 

 Click Finish when complete. 

NOTE:  If you check “Limit To 
List” then it will display a drop-

down list, but it will not allow you 
to type an entry not in the list.  If 
you check “Allow Multiple 

Values” then it will display the 
list with a checkbox in front of each value.  You can check the box for more than 

one value.  (For example if someone worked part time on two campuses.) 

 In Design View; add a field at the bottom (below Comments) called 
Documentation and select Attachment as the data type.  Save the Table 

again.  (There are twelve fields in the table.) 

 In Datasheet View, the Documentation column displays a paper clip symbol 

at the top instead of the field name.  

 In the figure on the right, the top 

paperclip is in place of a field name.  The 
paperclip (2) means there are 2 
attachments in the first record.  (0) 

means there are no attachments in the 
second record. 

 In Design View, look at the 
Documentation Field Properties.  For 
the Caption, type Resume & Other 

Documents.  The Caption displays at 
the top of the field (column).  Save the 

Faculty Table. 

 The Attachment data type is useful for attaching images, resumes, descriptions 
and other file types, etc. 

 To attach documents and images, either double click on the cell containing the 
paper clip image, or with the cell active, right-click on the Attachment field and 

select Manage Attachments from the pop-up menu. 

 In the Manage Attachments box, shown on the right, all the attachments for a 
specific field are listed.  Click Add to attach a file.   

 Click Remove to remove a file already attached.   

 Use Open to see the contents of an attached file.   
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 Click OK when finished with the 
Manage Attachments 

window. 

 Save and Close the table. 

NOTE:  When viewing the 
Attachment field of a record (in a 
form), click once on an attachment 

and the scroll buttons shown here, 
are visible.   

 

 

 Click Forward or Back to 

scroll through the attachments.  
Click the paperclip to bring up 

the Manage Attachments 
dialog box. 

 

 In a form, attached photos are displayed, other documents are shown as an 
icon. 

 

Closing a database 

 Click the File Tab to display the menu. 

 Select the Close Database command. 

 Save your changes.  The database closes and it returns to the Blank Database 

screen. The database named Faculty is in the Recent list. 

 

Navigation Pane 

The Navigation Pane is located on the left side of the screen and displays all 

objects contained within the database, including all tables, forms, queries and 
reports. 

 Open the database Sample2011 

The Navigation Pane can be minimized by clicking on the (left pointing) 
arrows button, top right of the pane.  

To restore the Pane to normal view, click the right pointing arrows button at 
the top right of the pane. 

 Object categories can be minimized / maximized using the upward/downward 

pointing arrow buttons to the right of the object type. 
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 In the figure, All Access Objects are 

displayed:  Tables, Queries, Forms, and/or 
Reports.  Queries are also shown in the 

figure.  It may not be evident which Table 
goes with each Query, because Tables and 
Queries can be named anything. 

 A preferable way to view the Objects is by All 
Tables set to Tables and Related Views.  

This view shows the Table and its Objects 
together.  

 

 To select the way you would like to view the 
objects, click the (1) Menu button which is the 

down pointing arrow in the top right corner of 
the Navigation Pane (see figure on right). 

 

 Select Tables then Tables and Related Views.  
In this way tables will be listed with all their 

individual Forms, Queries, and Reports.  [Each 
object type has its own icon in front of the name.  

See the figure lower right.] 

 

 Experiment with the views.  Leave it displayed by 

All Tables and Tables and Related views.  
(See the figure on the right.) 

 

 The objects are shown listed with the Table.  In 
the example, the Class Schedule 2009-10 

group shows one Table and four related objects.  
The related objects include two Queries, one 

Form, and one Report.  This makes it easy to 
know which table it is pulling information from. 
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Primary Key 

 A Primary Key is used as a unique identifier for each record in a table and is 
essential when working with relational tables. 

 To be effective, a Primary Key cannot have duplicate entries and must be set 

on a field with a unique identifier.   

 When creating a new table, Access automatically adds the ID field with an 

AutoNumber data type.  By default the ID field is also the Primary Key. 

 Examples of other fields suitable to 
be set as a Primary Key are: 

passport, social security and driver‟s 
license numbers, military 

identification, tax, workplace or 
personal identification numbers, 
unique to each individual.   

 The Primary Key will not allow 
duplicate entries in the Primary 

Key field for the table. 

NOTE: A Primary Key field can never be empty. 

 Open the Sample2011 database. 

 Open the Class Schedule table. 

 Switch to the Design View, by clicking on the View button. 

 The Primary Key symbol identifies the Class Number field as being the 
Primary Key. 

NOTE: The Primary Key button is in the Tools group on the ribbon. 

 To use another field as the primary key, select the field (Course Name) and 
then click the Primary Key button on the ribbon.  The Primary Key symbol is 

now displayed beside the Course Name field. 

NOTE: The Course Name field is NOT a suitable data type to become a primary 
key, as data within this field is unlikely to be unique. 

 Reset the Primary Key to the Class Number, before continuing. 

 Close the Sample2011 database.   

 Open the Faculty database again. 
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Input Mask Wizard 

 Input Masks are used to restrict how data is entered.  By forcing users of the 
database to enter data in a fixed format it greatly reduces the chances of data 
input errors.  There is usually less typing with an Input Mask because 

parenthesis and dashes are put in for you. 

NOTE: Input Masks only work with Text and 

Date data types.  When creating a field with 
information such as phone numbers, social 
security numbers, id numbers, etc. it needs 

to be a Text field if you want to type 
parenthesis, dashes, or spaces in the field.  

(A Number field will only allow digits, 
decimal points, or negative signs to be 
typed.) 

 The Faculty database is open, open the 
Faculty Table in Design View.   

 Click in the Phone field in the Field Properties.  Notice the … button (circled in 
the figure above) on the right end of the line 
for Input Mask. 

 Click the … button. This will start the Input 
Mask Wizard. 

 [If prompted to save the table, click Yes.] 

 The Input Mask Wizard dialog box is 
displayed.  (see figure on right) 

 Select Phone Number under Input Mask. 

 In the Try It: box, type 10 digits and see 

how it fills in the parenthesis, space and 
dash. 

 Click the Next button.  

 The second screen allows you to change the 
Placeholder character.  For example, you 

could change from using underline _ to using 
a pound sign #.  (It is easier to see how 

many characters you can type with # 
because the _ run together as a line.)   

 Change the Placeholder character and then 

click in Try It: and type 10 digits to see it 
work. 

 Click the Next button.  

 



Dallas County Community College District 

LeCroy Center Page 26 of 44 

 The last screen of the Input Mask Wizard asks if you wish to store the data 
with or without the symbols in the Input Mask.  In other words, store a phone 

number like this:  (972) 495-1234 or 
9724951234 ? (with or without the symbols, 

as ten digits or fourteen characters?)   

 There are two questions you should ask 
yourself – If I export this to a text file will it 

matter whether the parenthesis, space, & 
dash are there or not?  And/or Does four 

more characters per record make that much 
difference in storage space? 

 Select the way you want it to store, then click the Finish button. 

NOTE: The Input Mask has additional codes that can be used to create an Input 
Mask without using the Input Mask Wizard.   

 Click the Datasheet View button to switch to Datasheet View. 

 When prompted, click the Yes button to save the changes. 

 Using the mouse pointer, select the next blank cell at the bottom of the Phone 

column. 

 Notice the new Input Mask appears.  Type in a phone number. 

NOTE: If at any stage incomplete data has been entered into the field using an 
input mask, you will not be able to move out of the field or select another function 

until the data is either removed or completed.  

 

Input Mask Details 

 An Input Mask can be typed instead of using 
the Wizard.  It is divided into three sections 

separated by semi-colons (;).   

 The first section is mandatory.  The sample consists of characters with special 
meaning such as 9 means it is optional – you can leave it blank or type a digit, 

but it will only accept digits.  The character 0 means it is mandatory to type a 
digit.   

 The second section will either be a 1(to store only what is typed) or a 0 (to store 
all characters such as parenthesis or dash along with the typed data.   

 The # at the end indicates the chosen placeholder.  Anything in quotes or 
preceded by a backslash \ will appear as shown.  The ! at the beginning means 
if there are optional characters, it will fill from right to left. 

 

!\(999”) ”000\-000; 0; # 
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Manipulating Records 

Using the Undo command 

 Like other Microsoft Office applications, the Undo button is located on the Quick 
Access Toolbar.  The Undo command (CTRL-Z), allows the user to undo some 

actions.  You can Undo deleting or editing the contents of a field.  However, it 
will Undo all of the actions in the same record at one time.   

 Unlike other Office applications however, when working with tables, the Undo 
function will only undo the actions on one record.  You cannot  UNDO the 
deleting of an entire record.  (It warns you accordingly.) 

 Open the Faculty table (in the Faculty database).  Experiment with creating a 
new record, making changes and then try clicking the Undo button.  Access will 

Undo sorting and some other changes. 

 

Deleting data within a record 

 Deleting data in a record is similar to editing data in a record; however, there 
are a number of considerations to take into account. 

NOTE:  Data cannot be deleted from fields where the required field property is set 
to Yes, as this prevents the field from being left blank. 

 To remove data from a record, select the information in the field, press the F2 
key to activate editing mode, then use either the Delete or the Backspace key 
to delete the entry. Press the Enter key to commit the changes. 

 The pointer moves to the next column, leaving the field empty. 

 

Deleting a single record 

 Occasionally you may need to remove a record from a 

table.  There are several ways to do this.   

 First select the record:  move to the selection box to the 
left of the first field, click to select the whole row (record). 

 Click the Delete button in the Records group of the 
Home ribbon, (top right figure) or click Delete Record in 

the drop-down list 

 Press the Delete key on the keyboard, or 

 Right-click the mouse, click Delete Record in the popup 

menu displayed (bottom right figure). 

 A warning is displayed.  Click Yes to confirm deletion. 

NOTE:  As mentioned previously, Undo is not available when 
deleting records, therefore any record deletions will be final.  

When deleting records from a table, the unique number in an 
ID (AutoNumber) field is also deleted and will not be reused. 
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Deleting multiple records 

 If a group of records needs to be deleted the records must be together in the 
table.  There are two ways to select the records: 

 Move the pointer to the selection box to the left of the first record,  click and 

drag down to highlight the block of records to be deleted, or 

 Click in the selection box of the first record to delete, move the pointer down (do 

NOT DRAG); while pointing to the last record to select, hold the SHIFT key down 
and click. 

 Once the records are selected, click Delete and respond Yes to the warning. 

 

Find a Record 

In a small table it is easy to find a specific record.  However, if 
your table has hundreds or thousands of records you need help 

from Access. 

 Open the Sample2011 database and Open the Class 
Schedule 2009-10 table. 

 Click in the field you will be searching, for example click in Course Name if you 
will be searching for a class with a 

specific name.  

 Click in Course Name.   

 Click the Find button, it is in the 

Find group in the center of the 
Home ribbon.   

 A dialog box like the one shown in 
the figure on the right is 
displayed. 

 Find What: (type the text you want to find)  

 Look In: has Current Field (which means it is important to click IN the field 

that you are searching first).  The other choice is Current Document, in a Table 
that means all fields are searched.   

 Match:  chose from:  Any Part of Field, Whole Field, or Start of Field; any 

part of field means what you are searching for could be anywhere in the field, 
whole field means it can only have what you‟re searching for; and start of field 

means it will only be searching the beginning of the field for the text you typed. 

 Search:  chose from:  All, Down, Up; All will search all records no matter 
where you start the search, Down will start on the current record and search 

Down (stopping on the last record), Up will search from the current record to 
the top and then stop searching. 

 Match Case if checked it will only search for the exact case that you typed in 
the Find What: box.  If it is unchecked it does not look at the “case” only the 
text typed. 
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 Search Fields As Formatted if checked will only look for data entered in the 
same format.   

 For example, if a Time field is formatted like this:  4:30:00 PM  it will NOT find 
4:30 PM if Search Fields As Formatted is checked 

 Find What: Introduction 

 Look In:  Current field 

 Match:  Any Part of Field 

 Search:  All 

 Click the Find Next button on the right. 

 When it has searched all the records, 
it will display the message shown on 
the right.  Click OK and it will end the 

Find. 

 Close the Class Schedule table. 

 

Editing data within a record 

 The Sample2011 database should be open.  Open the Students table. 

 Use the Find command to find the student whose last name is McGeary 

 Once you find him, click in his Address field, press F2 to edit, (or click and 

type) change his address from 101 Belt Line Rd to 2005 Belt Line Rd with the 
same city and zip code. 

NOTE: By placing the pointer in any cell, then using the arrow keys to move to 
another cell, automatically activates edit mode.  Alternatively, you can also click 
and drag to highlight data within a cell and replace it. 

 

Find and Delete a Record 

 Keep the Students table open. 

 Click in the Last Name field, click the Find button  

 Type the Last Name:   Love  in the Find What box 

 Click Find Next 

 It finds the only person whose last name is Love (Student ID 9).  Close Find. 

 Select the whole record by clicking the selection box at the far left edge of the 
table 

 Press the Delete key on the keyboard OR click Delete in the Records group of 
the Home ribbon.  Respond by clicking Yes to delete the record.  (There is no 
Undo on deleting records.) 

 Close the tables and close the Sample2011 database.  
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Manipulating Tables 

Rename a Table 

 Open the Faculty database. 

 Right-click on the table (Faculty) in the 

Navigation Pane on the left.  

 Select Rename 

 Type Faculty 2011 as the new name, press 
Enter. 

 

NOTE: Objects cannot be renamed while open, 

so if you opened the Faculty table, you will 
need to close it to continue.  To close a table, 
click the x in the top right corner of the table window.  

 Leave the Faculty database open.   

 

Copy a table 

 

 To copy an object, right-click on the name in the Navigation Pane, in the pop-

up menu, click Copy. 

 Right-click in the Navigation Pane, click Paste 

 In the dialog box that pops up, type the name for the copy  

 Three choices (for what can be copied) are given.  (see the figure below) 

 Copy the Faculty 2011 table.  Name the copy:  Copy of Faculty 2011  

Paste Options are:   

Structure Only – copies fields, including defaults, validations, input masks, etc. 

Structure and Data – copies the structure and the information typed in the table. 

Append Data to Existing Table – will add the copied data to another, existing 
table. 

 

 Select Structure Only 

 Click OK 

 Open the copy of the table to 

see what is in it. 
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Delete a table 

 

 To delete an object, i.e. a table from a 

database, that object must be closed so first 
close any open tables 

 

 In the Navigation Pane, right-click on the 
name of the table.  From the popup menu 

select the Delete command (see figure on 
right). 

 

 Click Yes to confirm deletion on the warning 
message. The table is deleted from the 

database. 

 

 Close the Copy of Faculty 2011 table.   

 

 Delete the Copy of Faculty 2011 table 

 

 Close the Faculty database. 
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Sorting and Filtering 

Sorting by a single field 

 Sorting arranges the data within a table into alphabetical or numerical order, 

making it more effective and easier to use.  Data is easier to find when we know 
it is sorted in some order, for example, even a simple computerized address 

book is sorted alphabetically from A – Z and calendars are sorted by date order. 

 Open the Sample2011 database.   

 Double-click the Students table to open it. 

 

NOTE: A table, query, form, or report can be sorted on one or more fields, with the 

exception of memo, attachment or OLE data type fields.  

 To sort a single field, first select the field you want to sort.  Click in the Last 
Name field name to highlight the column. 

 

 Within the Home tab, in the Sort & Filter group, click on the AZ (Ascending) 
button (top left in group) 

 The table is now sorted in alphabetical order by Last Name.  However, students 
with the same last name should also be sorted by their First Name. 

NOTE: A sort will remain active until removed; even when a table is closed and 
reopened (if the table was saved prior to closing).  There are some students with 

the same last name, their first names should be sorted where the last name is the 
same. 

 To remove a sort, click the Remove Sort button in the Sort & Filter group 

(bottom left in group).  The table returns to the default (original) sort order.  
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Sorting by multiple fields 

 To sort on two or more fields, the fields need to be next to each other in the 
order that they will be sorted. 

 In the table figure, the First Name and the Last Name fields are side by side, 

with the First Name field to the left of the Last Name field.  This positioning is 
relevant when using a sort on multiple fields in a table, as the left most field in 

the selected group of fields, takes priority over the fields to the right. 

 A multi-field sort is needed to organize the Last Name into alphabetical order 

first, and then sort the First Name field so that names within that field are 
alphabetical according to each different Last Name. 

 Move the Last Name field (column) in front of the First Name field.  Select the 
Last Name column, release the mouse.  Point to the top of the Last Name 
column, hold down the mouse and drag in front of First Name.  Release the 

mouse button when you see the black line in front of First Name column (as 
seen in the figure above). 

 Place the pointer over the First Name field name (at 
the top of the column) without clicking.  When the 
pointer changes to the down arrow shape (circled 

in figure on right), click and drag (left) across the 
Last Name field in one movement, to highlight both 

fields.  Release the mouse button to complete this 
task.  The two columns will be highlighted. 

 Click the Ascending button in the Sort & Filter group. 

 Click anywhere in the table to clear the highlighting from the two fields.  If there 
are two or more records with the same last name, the First names are sorted 

within the Last Name field.  [Look at your table, there are two each of 
Johnsons, Perrys, and Smiths, they should all be sorted by first name within the 

same last name.] 

 Notice the tiny arrows (circled in the 
figure).  These indicate which 

columns have been sorted; arrows 
pointing up mean Ascending 

(arrows pointing down are 
Descending). 
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 To put the table back in the order the records 
were in originally, click the Remove Sort 

button in the Sort & Filter group. 

NOTE: When sorting text fields that contain null 

or zero-length strings, the null values are listed 
first (ascending order A-Z) and last (descending 
order Z-A). 

Text Filters 

 Text Filters provide a means to find one or more specific records in a table or 

form or print specific records in a report, table, or query. 

 By using criteria in a filter, you effectively display only those records matching 

the criteria.  Records not matching the criteria disappear from view, hence the 
term „filter‟.  For example, if you only want to display records that fall between 
the first day of a month and the last day of a month, you can apply a filter, 

specifying the oldest date and the newest date - only records matching the 
criteria remain visible in the table. 

 Filters remain in place until they are removed or until the object is closed. 

 More than one filter may be active at one time, although only one filter per field 
is possible.  Setting a new filter on a field will effectively remove the previous 

filter for that field before applying the new filter. 

 

Applying a single filter 

 The Sample2011 database is already open, open the Class Schedule table. 

 A single filter is one that is applied to a single field, using the quick filter options 

made available in Access 2010. 

 Click anywhere in the Subject 
field.   

 Click the Filter button in the Sort 
& Filter group on the Home 

ribbon. 

 A Filter popup menu is displayed. 

 The menu is divided by lines, into 

three sections; however, only the 
second and third areas of the 

menu apply to filtering. 

 For now, ignore the A-Z sort 
section as this will be covered in a 

subsequent section.   
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 In the lower section of the popup menu, you will notice a group of check boxes.  
These check boxes represent all the available (unique) subjects entered into the 

Subject field (or whatever field you clicked in). 

 At the top of the check box group is one labeled (Select All). 

 Click the (Select All) check box to un-check all the boxes. 

 To locate all records for those with the subject “Email”, click the Email check 
box. 

 Click the OK button. Six records are displayed with Email in the Subject field. 

 A button is displayed to the right of the field name Subject or any field which 

has a filter applied. Click the button and select a different Subject to filter. 

 Within the ribbon Sort & Filter group, the Toggle Filter button is now active. 
Toggle Filter effectively 

turns the filter on and off, 
switching between the 

filtered view and normal 
view (unfiltered). 

 The Filtered button, 

previously grayed out is 
now active in the record 

navigation bar at the 
bottom of the table (see 

figure on right). 

 The Filtered button works in exactly the same way as the Toggle Filter button 
in the Sort & Filter group in the ribbon.  Click on the Filtered button once.  

The table is temporarily unfiltered and ALL records are visible.   

 Click the Unfiltered button (or the Toggle Filter button) to revert back to the 

filtered view. 

Clearing a single filter 

 To clear a single filter, you will need to either place 

the pointer in any row of the appropriate column or 
click on the field name at the top of the column to 

highlight the whole column. 

 Select and highlight the Subject column by clicking 

on the field name. 

 In the Sort & Filter group, click the large Filter 
button. 

NOTE: Only when a filter is in use, will the Clear filter 
from [Field] option be available in the list, otherwise 

the option will be grayed out.  Click the Clear filter 
from Subject option from the list to remove the filter.  
The table again displays all records. 
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Creating other types of filters 

Creating Text Filters 

 Using a filter on one field helps reduce the list of records to those that meet the 

criteria set, however there may be occasions when you want to be even more 
specific about the records you wish to display.  This can be accomplished by 

setting different filters across multiple fields. 

NOTE: Only one filter can be specified per field, however multiple criteria can be 
included in one filter. 

 

 To set filters on multiple fields, you simply follow the steps used for creating a 

simple filter and repeat the process across additional fields.  The only subtle 
difference is in the process of clearing multiple field filters, covered later in this 
section. 

 With the Class Schedule table open, select the Subject field. 
 

 Click on the (1) down arrow 
button to the right of the Subject 

field name. (top left in the figure) 

 In the popup menu click the (2) 
Text Filters command. 

 From the submenu displayed, click 
(3) Begins With. 

 
 
 

 

NOTE: Text Filters are custom filters that allow you to specify criteria without 

having to use operators such as <, >, =, etc. 

 

 The Custom Filter dialog box is displayed. 

 Type MS into the Subject begins with box. 

 Click the OK button. 

 

 Only records matching the criteria, “begins with MS” in the Subject field remain 
displayed.   [76 of the 110 records match this criteria] 
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Date & Number Filters 

 Click within the # Sessions field 
column. 

 Click the (1) down arrow button to the 
right of the # Sessions field name. 

 When the Filter popup menu is 
displayed, click (2) Number Filters 
command. 

 From the sub menu displayed, click (3) 
Greater Than. 

 

 Type 5 in the box. 

 Click on the OK button. 

 Only records matching a Subject beginning 
with „MS‟ and “# Sessions greater than or 

equal to 5” remain displayed. 

 Select and highlight the 
Beginning Date field. 

 Click on the down arrow 
button to the right of the (1) 

Beginning Date field name. 

 When the filter dialog box is 
displayed, select the (2) Date 

Filters command. 

 From the submenu displayed, 

click (3) Between ...  

 The Custom Filter dialog box 
is displayed. 

 Into the Oldest section, type 
in 1/1/2010. 

 Into the Newest section type 
in 3/31/2010.  

 Click on the OK button. Now 

the number of records matching the three 
filters is reduced even further. 

 

 (Only 23 records match the three filters:  

Subject, # Sessions, and Beginning Date.) 
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Clearing multiple filters 

 

 It is possible to clear each filter, one at a time, 

by clicking the filter button at the top of the 
column and clicking Clear filter from <field>.  

 

 To clear all filters at once, click (1) Advanced 
button on the Home ribbon, in the Sort & Filter 

group. From the list, select the (2) Clear All 
Filters option. The filters will be removed and all 
records will once again be displayed. 

 

Using Advanced Filter/Sort 

 Advanced Filter/Sort makes it possible to easily do multi-column sorting or 

advanced multi-column filtering or to combine filtering and sorting in one 
operation. 

 The Sample2011 database should be open. The Class Schedule table should 
also be open.  All previously set filters should be cleared. 

 

Multi-column sorting: 

 

 In the Sort & Filter group, click (1) 
Advanced. 

 Select (2) Advanced Filter/Sort  from 
the pop-up menu. 

 The Advanced Filter window opens. 

 

 Since sorting needs to be set up so that 

the columns to be sorted should be in 
order of importance from left to right, 
the columns need to be added to the 

bottom grid in that order. 
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 To place a field in the grid you 

can (1) double click it in the 
field list OR (2) click the drop-

down arrow in the column grid 
and click once on the field 
name in the drop-down list. 

 Put the following fields in the 
grid in this order:  Date, 

Subject, Campus Location, 
and StartTime. 

 Under each field, on the Sort: 

line select (3) Ascending from 
the drop-down list. 

 Select Advanced in the Sort & 
Filter group. 

 Select Apply Filter/Sort. 

 Look at the 8/13/2009 Start 
Times, they are not in order.  

Because StartTime is the last 
field to be sorted, it is not working correctly.  The StartTime field should be 

between Date and Subject.   

 Click Advanced. 

 Select Advanced Filter/Sort. The grid is re-displayed. 

 Select the StartTime field by clicking at the top of the column with the black 
down arrow.   

 Release the mouse button, move the mouse to the top of the selected column, 
when you see a small 
white arrow, hold down 

the mouse button and 
drag the column to the 

left.  Release the 
mouse button when the 
vertical black line is 

between Date and 
Subject. 

 Click Advanced.  

 Select Apply Filter/Sort.  The Dates with two Start Times are in order by 
Start Time now.  [Look at 8/13, 9/16, and 10/1 to verify.] 

 Select Advanced Filter/Sort to display the grid. 
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Adding Criteria to the Advanced Filter/Sort: 

 Click on the Criteria line of the Date column. 

 Type this:    BETWEEN 12/15/2009 AND 

3/15/2010   (see the figure on the right) 

 Click Advanced.   Select Apply Filter/Sort.  

Look at the table, instead of 110 records, you 
see  33 Filtered records 

 

 

 Click Advanced.  Select Advanced Filter/Sort. 

 Click on the Criteria line of the Subject column. 

 Type this:  MS*   (ms* works the same) 

 Click Advanced.   Select Apply Filter/Sort.   

 Look over the results of the additional Filter. 

 

NOTE:  The asterisk * is used as a wildcard.  By 
putting MS* that means we are searching for records that start with MS and may 
or may not have text after the MS. 

 

 Click Advanced.  Select Advanced Filter/Sort. 

 Click on the Criteria line of the Campus Location column. 

 Type this:  “CVC” OR “EFC” 

 Click Advanced.   Select Apply Filter/Sort.   

 Look over the results of the additional Filter.  All three filters are shown below. 
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 Above is the filtered Class Schedule Table.  Twelve records met all the criteria.   

NOTE:  Unaffected fields (columns) in the above 
figure are hidden.   

 To Hide/Unhide a field, right-click the selected 

column(s) in the table, select Hide Field(s) (or 
Unhide Fields). 

 If you would like to use this same filter again in 
the future, you must save it as a query.  

 First display the grid, click Advanced then click 

Advanced Filter/Sort.  

 In the grid, click Advanced, Save As Query in 

the pop-up menu. 

 The Save As Query box pops up, asking for the 
Query Name. 

 Type a meaningful name that will help you remember what the filters do. 

 Click OK. 

 To use the saved Query in the future, 
just double click to open it and it will 
display the current records that meet 

the criteria.  If new records have been 
added to the table, they will show in 

the Query if they meet all of the 
criteria. 

 Click Advanced, Close (to leave Advanced Filter/Sort grid).   

 To clear the filter/sort, select Advanced then Clear All Filters. 

 Close the table.  Close all tables and other objects. 
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Backup your databases 

 With your database open, be sure all tables and other objects are closed. 

 Click the File tab. 

 Click (1) Save & Publish.  

 Click (2) Back Up Database. 

 Click (3) Save As 

 Select the drive and folder in which you wish to store your backups.  [You might 
want to make a new folder called Access Backups to store all of your backups.] 

 The backup file will be given a name with the date in the name like this:    

Classes_2011-01-28.accdb 

 

You can change the filename and/or the location of the backup.   

 Click Save 

 Close the database 

 Close Access. 

 





 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Class registration and schedule: 

http://helpdesk.dcccd.edu 

 

or 

 

www.dcccd.edu  

 Employees > Training and Development > Software Training and 
Support 

Dallas TeleCollege at the R. Jan LeCroy Center for Educational 

Telecommunications 

District Software Training & Support 

9596 Walnut St. Dallas, TX 75243 

 

STAFF Helpdesk Phone: 972-669-6477 

STUDENT Helpdesk Phone: 972-669-6402 

E-mail: softwaresupport@dcccd.edu 

Web Site: http://helpdesk.dcccd.edu 

Training Web Site:  http://employeetraining.dcccd.edu  

 

http://www.dcccd.edu/
http://helpdesk.dcccd.edu/
http://employeetraining.dcccd.edu/

